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Knowing is not enough; we must apply. Willing is not enough; we must do.
—Johann von Goethe

In this lab we build our ﬁrst simulation model using ProModel. In Section L4.1
we describe some of the basic concepts of building your ﬁrst ProModel simulation
model. Section L4.2 introduces the concept of queue in ProModel. Section L4.3
lets us build a model with multiple locations and multiple entities. In Section L4.4
we show how to modify an existing model and add more locations to it. Finally,
in Section L4.5 we show how variability in arrival time and customer service time
affect the performance of the system.

L4.1 Building Your First Simulation Model
In this section we describe how you can build your very ﬁrst simulation model
using ProModel software. We introduce the concepts of locations, entities, entity
arrivals, processes, and routing.
Customers visit the neighborhood barbershop Fantastic Dan for a haircut.
The customer interarrival time is exponentially distributed with an average of
10 minutes. Dan (the barber) takes anywhere from 8 to 10 minutes, uniformly distributed (mean and half-width of 9 and 1 minute respectively) for each haircut.
This time also includes the initial greetings and the transaction of money at the
end of the haircut. Run the simulation model for one day (480 minutes). Find
these answers:
a. About how many customers does Dan process per day?
b. What is the average number of customers waiting to get a haircut? What
is the maximum?
409
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FIGURE L4.1
General Information
for the Fantastic Dan
simulation model.

c. What is the average time spent by a customer in the salon?
d. What is the utilization of Barber Dan?
e. What is the maximum and average number of customers waiting for a
haircut?
From the menu bar select File → New. In the General Information panel
(Figure L4.1) ﬁll in the title of the simulation model as “Fantastic Dan.” Fill in
some of other general information about the model like the time and distance
units. Click OK to proceed to deﬁne the locations.
From the menu bar select Build → Locations. Deﬁne two locations—
Waiting_for_Barber and Barber_Dan (Figure L4.2). Note that the ﬁrst location
is actually a region (it is the icon that looks like a square box). A region is a
boundary used to represent a location’s area. When the model is running the
region is not visible. The icon selected for the second location is actually called
operator. We changed its name to Barber_Dan (Name column in the Location
table).
Check off the New button on the Graphics panel (Figure L4.3) and click the
button marked Aa. Click on the location icon in the Layout panel. The name of the
location (Barber_Dan) appears on the location icon.
Deﬁne the entity (Figure L4.4) and change its name to Customer. Deﬁne
the processes and the routings (Figures L4.5 and L4.6) the customers go
through at the barbershop. All customers arrive and wait at the location
Waiting_for_Barber. Then they are routed to the location Barber_Dan. At this
location the barber performs the haircut, which takes an amount of time
uniformly distributed between 8 and 10 minutes or Uniform (9,1). Use the stepby-step procedure detailed in section L2.2.4 to create the process and routing
tables graphically.
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FIGURE L4.2
Deﬁning locations Waiting_ for_Barber and BarberDan.

FIGURE L4.3
The Graphics panel.
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FIGURE L4.4
Deﬁne the entity—Customer.

FIGURE L4.5
Process and Routing tables for Fantastic Dan model.

FIGURE L4.6
Process and Routing tables for Fantastic Dan model in text format.

To deﬁne the haircut time, click Operation in the Process table. Click the button with the hammer symbol. A new window named Logic Builder opens up.
Select the command Wait. The ProModel expression Wait causes the customer (entity) to be delayed for a speciﬁed amount of time. This is how processing times are
modeled.
Click Build Expression. In the Logic window, select Distribution Function
(Figure L4.7). In the Distribution Function window, select Uniform distribution.
Click Mean and select 9. Click Half-Range and select 1. Click Return. Click
Paste. Close the Logic Builder window. Close the Operation window.
Finally the customers leave the barbershop. They are routed to a default location called EXIT in ProModel. When entities (or customers) are routed to the
EXIT location, they are in effect disposed from the system. All the information associated with the disposed entity is deleted from the computer’s memory to conserve space.
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FIGURE L4.7
The Logic Builder
menu.

TABLE L4.1 Commonly Used Distribution Functions
Distribution

ProModel Expression

Uniform
Triangular
Exponential
Normal

U (mean, half-range)
T (minimum, mode, maximum)
E (mean)
N (mean, std. dev.)

The distribution functions are built into ProModel and generate random values based on the speciﬁed distribution. Some of the commonly used distribution
functions are shown in Table 4.1.
Now we will deﬁne the entity arrival process, as in Figure L4.8.
Next we will deﬁne some of the simulation options—that is, run time, number of replications, warm-up time, unit of time, and clock precision (Figure L4.9).
The run time is the number of hours the simulation model will be run. The number of replications refers to number of times the simulation model will be run
(each time the model will run for an amount of time speciﬁed by run hours). The
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FIGURE L4.8
Customer arrival table.

FIGURE L4.9
Deﬁnition of
simulation run
options.

warm-up time refers to the amount of time to let the simulation model run to
achieve steady-state behavior. Statistics are usually collected after the warm-up
period is over. The run time begins at the end of the warm-up period. The unit of
time used in the model can be seconds, minutes, or hours. The clock precision
refers to the precision in the time unit used to measure all simulation event
timings.
Let us select the Run option from the Simulation Options menu (or click
F10). Figure L4.10 shows a screen shot during run time. The button in the middle
of the scroll bar at the top controls the speed of the simulation run. Pull it right to
increase the speed and left to decrease the speed.
After the simulation runs to its completion, the user is prompted, “Do you
want to see the results?” (Figure L4.11). Click Yes. Figures L4.12 and L4.13 are
part of the results that are automatically generated by ProModel in the 3DR
(three-dimensional report) Output Viewer.

Harrell−Ghosh−Bowden:
Simulation Using
ProModel, Second Edition

II. Labs

Lab 4

4. Building Your First
Model

Building Your First Model

© The McGraw−Hill
Companies, 2004

415

FIGURE L4.10
Screen shot at run time.

FIGURE L4.11
Simulation complete
prompt.

FIGURE L4.12
The 3DR Output
Viewer for the
Fantastic Dan model.

Note that the average time a customer spends waiting for Barber Dan
is 22.95 minutes. The average time spent by a customer in the barbershop is
32.28 minutes. The utilization of the Barber is 89.15 percent. The number of
customers served in 480 minutes (or 8 hours) is 47. On average 5.875 customers
are served per hour. The maximum number of customers waiting for a haircut is 8,
although the average number of customers waiting is only 2.3.
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FIGURE L4.13
Results of the Fantastic Dan simulation model.

L4.2 Building the Bank of USA ATM Model
In this section we describe how you can build a simpliﬁed version of the automatic teller machine (ATM) system model described in Lab 3, Section L3.1, using
ProModel software. We also introduce the concept of a queue.
Customers arrive to use a Bank of USA ATM. The average customer interarrival time is 3.0 minutes exponentially distributed. When customers arrive to the
system they join a queue to wait for their turn on the ATM. The queue has the
capacity to hold an inﬁnite number of customers. Customers spend an average of
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2.4 minutes exponentially distributed at the ATM to complete their transactions,
which is called the service time at the ATM. Build a simulation model of the Bank
of USA ATM. Run the simulation model for 980 hours.
a.
b.
c.
d.
e.

About how many customers are served per hour?
What is the average customer waiting time in the queue?
What is the average time spent by a customer in the system?
What is the utilization of the ATM?
What are the maximum and average numbers of customers waiting in the
ATM queue?

From the menu bar select File → New. In the General Information panel
(Figure L4.14) ﬁll in the title of the simulation model as “Bank of USAATM.” Fill
in some of the other general information about the model like the time and
distance units. Click OK to proceed to deﬁne the locations.
From the menu bar select Build → Locations. Deﬁne two locations—ATM
and ATM_Queue (Figure L4.15). The icon selected for the ﬁrst location is actually
called brake. We changed its name to ATM (Name column in the Location table).
The icon for the second location (a queue) is selected from the graphics panel.
The icon (third from top) originally looks like a “ladder on its side.” To place it
in our model layout ﬁrst, left-click the mouse at the start location of the queue. Then
drag the mouse pointer to the end of the queue and right-click. Change the name of
this queue location from Loc1 →ATM_Queue. Now double-click theATM_Queue
icon on the layout. This opens another window as follows (Figure L4.16). Make
sure to click on the Queue option in the Conveyor/Queue options window. Change
the length of the queue to be exactly 31.413 feet.

FIGURE L4.14
General Information
for the Bank of USA
ATM simulation
model.
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FIGURE L4.15
Deﬁning locations ATM_Queue and ATM.

FIGURE L4.16
Click on the Queue
option in the
Conveyor/Queue
options window.
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Check off the New button on the graphics panel (Figure L4.15) and click the
button marked Aa (fourth icon from top). Click on the location icon in the layout
panel. The name of the location (ATM) appears on the location icon. Do the same
for the ATM_Queue location.
Deﬁne the entity (Figure L4.17) and change its name to ATM_Customer.
Deﬁne the processes and the routings (Figures L4.18 and L4.19) the customers
go through at the ATM system. All customers arrive and wait at the location
ATM_Queue. Then they are routed to the location ATM. At this location the
customers deposit or withdraw money or check their balances, which takes an
average of 2.4 minutes exponentially distributed. Use the step-by-step procedure
detailed in section L2.2.4 to create the process and routing tables graphically.
To deﬁne the service time at the ATM, click Operation in the Process table.
Click the button with the hammer symbol. A new window named Logic Builder
opens up. Select the command Wait. The ProModel expression Wait causes the
ATM customer (entity) to be delayed for a speciﬁed amount of time. This is how
processing times are modeled.
FIGURE L4.17
Deﬁne the entity—ATM_Customer.

FIGURE L4.18
Process and Routing tables for Bank of USA ATM model.

FIGURE L4.19
Process and Routing tables for Bank of USA ATM model in text format.
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FIGURE L4.20
The Logic Builder
menu.

FIGURE L4.21
Customer arrival table.

Click Build Expression. In the Logic window, select Distribution Functions
(Figure L4.20). In the Distribution Functions window, select Exponential distribution. Click Mean and select 2.4. Click Return. Click MIN. Click Paste. Close the
Logic Builder window. Close the Operation window.
Finally the customers leave the Bank of USA ATM. They are routed to a default location called EXIT in ProModel. When entities (or customers) are routed
to the EXIT location, they are in effect disposed from the system. All the information associated with the disposed entity is deleted from the computer’s memory to conserve space.
Now we will deﬁne the entity arrival process, as in Figure L4.21.
Next we will deﬁne some of the simulation options—that is, run time, number
of replications, warm-up time, unit of time, and clock precision (Figure L4.22). The
run time is the number of hours the simulation model will be run. In this example
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FIGURE L4.22
Deﬁnition of
simulation run options.

we are going to model 980 hours of operation of the ATM system. The number of
replications refers to the number of times the simulation model will be run (each
time the model will run for an amount of time speciﬁed by run hours). The warm-up
time refers to the amount of time to let the simulation model run to achieve steadystate behavior. Statistics are usually collected after the warm-up period is over. The
run time begins at the end of the warm-up period. For a more detailed discussion on
warm-up time, please refer to Chapter 9, Section 9.6.1 and Lab 9. The unit of time
used in the model can be seconds, minutes, or hours. The clock precision refers to the
precision in the time unit used to measure all simulation event timings.
Let us select the Run option from the Simulation Options menu (or click
F10). Figure L4.23 shows a screen shot during run time. The button in the middle
of the scroll bar at the top controls the speed of the simulation run. Pull it right to
increase the speed and left to decrease the simulation execution speed.
After the simulation runs to its completion, the user is prompted, “Do you want
to see the results?” (Figure L4.24). Click Yes. Figures L4.25 and L4.26 are part of
the results that are automatically generated by ProModel in the Output Viewer.
Note that the average time a customer spends waiting in the ATM Queue
is 9.62 minutes. The average time spent by a customer in the ATM system is
12.02 minutes. The utilization of the ATM is 79.52 percent. Also, 20,000 customers
are served in 60,265.64 minutes or 19.91 customers per hour. The maximum number of customers waiting in the ATM Queue is 31, although the average number of
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Screen shot at run time.

FIGURE L4.24
Simulation complete
prompt.

FIGURE L4.25
The output viewer for
the Bank of USA ATM
model.
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FIGURE L4.26
Results of the Bank of USA ATM simulation model.

customers waiting is only 3.19. This model is an enhancement of the ATM model
in Lab 3, Section L3.1.2. Results will not match exactly as some realism has been
added to the model that cannot be addressed in queuing theory.

L4.3 Locations, Entities, Processing, and Arrivals
In Sections L4.1 and L4.2 we have used the basic elements of ProModel. In this
section we incorporate locations, entities, arrivals, processing, and routing logic
into another simulation model example.
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Problem Statement—Multiple Locations, Multiple Entities
Wooden logs are received at the receiving dock of the Poly Furniture Factory at
the rate of one every 10 minutes. Logs go to the splitter, where four pieces are
made from each log. The splitting time is Normal (4,1) minutes. The individual
pieces go to the lathe, where they are turned for another Triangular (3,6,9) minutes
and made into rounds. The rounds go on to a paint booth, where they are converted into painted logs. Painting takes Exponential (5) minutes. Painted logs go
to the store. Consider a material handling time of one minute between each
process. Make a simulation model and run the simulation for 10 hours.
We are going to use AutoBuild, the automatic model-building feature of
ProModel, to help us build this simulation model step by step. Click AutoBuild
from the Tools menu. Fill in some of the general information about the model
(Figure L4.27). Deﬁne the locations (Figure L4.28)—receiving dock, splitter saw,
lathe, paint booth, and painted logs store. Note that the capacity of the receiving
dock location has been changed to inﬁnity (INF) to make sure that all incoming
entities (raw material) are allowed into the manufacturing facility.
Deﬁne the entities (Figure L4.29)—logs, piece, rounds, and painted logs.
Deﬁne the entity arrival process (Figure L4.30)—logs arriving to the location
receiving dock at the rate of one every 10 minutes.
Deﬁne the processes and the routings (Figure L4.31). All logs arrive at the receiving dock. From there they go to the splitter. At the splitter each log is made
into four pieces. To be able to model this, click on the Rule button in the routing
table. Change the quantity to four. This models the process of one log going into
the location splitter saw and four pieces coming out. Pieces are routed to the lathe,
where they become rounds. Rounds are routed to the paint booth, where they become painted logs. Painted logs are sent to the painted log store. Finally, the
painted logs are sent to the default location EXIT for disposal.
FIGURE L4.27
General information
for the Poly Furniture
Factory simulation.
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FIGURE L4.28
Locations in the Poly Furniture Factory.

FIGURE L4.29
Entities in the Poly Furniture Factory.

FIGURE L4.30
Entity arrivals in the Poly Furniture Factory.
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FIGURE L4.31
Processes and routings in the Poly Furniture Factory.

FIGURE L4.32
Simulation options in
the Poly Furniture
Factory.

The time to move material between processes is modeled in the Move Logic
ﬁeld of the Routing table. Four choices of constructs are available in the Move
Logic ﬁeld:
•
•
•

MOVE—to

move the entity to the end of a queue or conveyor.
MOVE FOR—to move the entity to the next location in a speciﬁc time.
MOVE ON—to move the entity to the next location using a speciﬁc path
network.
• MOVE WITH—to move the entity to the next location using a speciﬁc
resource (forklift, crane).
Deﬁne some of the simulation options: the simulation run time (in hours), the
number of replications, the warm-up time (in hours), and the clock precision
(Figure L4.32).
Now we go on to the Simulation menu. Select Save & Run. This will save the
model we have built so far, compile it, and also run it. When the simulation model
ﬁnishes running, we will be asked if we would like to view the results. Select Yes.
A sample of the results is shown in Figure L4.33.
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FIGURE L4.33
Sample of the results of the simulation run for the Poly Furniture Factory.
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L4.4 Add Location
Now let us add a location to an existing model. For the Poly Furniture Factory example in Section L4.3, we will add an oven after the painting booth for drying the
painted logs individually. The drying takes a time that is normally distributed with
a mean of 20 minutes and standard deviation of 2 minutes. After drying, the
painted logs go on to the painted logs store.
To add an additional location to the model, select Locations from the Build
menu. With the mouse, ﬁrst select the appropriate resource icon from the Graphics
toolbar (left-click), then left-click again in the Layout window. Change the name
of the location (in the Locations table) from Loc1 to Oven (Figure L4.34).
Locations can also be added from the Edit menu. Select Append from the Edit
menu. A new location called Loc1 is appended to the end of the Locations table.
Change the name to Oven. Deselect the New option in the Graphics toolbar. Select
an appropriate icon from the Graphics toolbar. Click in the Layout window.
To display the names of each location in the Layout window, ﬁrst select a location (left-click). Next deselect the New option in the graphics toolbar. Left-click on
the command button Aa in the Graphics toolbar (left column, fourth from top).
Finally, left-click on the location selected. The name of the location will appear in
the Layout window. Now it can be repositioned and its fonts and color changed.
The complete simulation model layout is shown in Figure L4.35. Note that the
capacity of the oven as well as the paint booth has been changed to 10. The processes
and routings are created as shown in Figure L4.36. At this point it is worthwhile to
note the differences between the capacity and the units of a location.
• Capacity: This is the number of units of entities that the location can hold
simultaneously. The default capacity of a location is one.
• Units: A multiunit location consists of several identical units that are
referenced as a single location for processing and routing purposes. A
multiunit location eliminates the need to create multiple locations and
multiple processes for locations that do the same thing. The default number
of units of a location is one.
FIGURE L4.34
Locations at the Poly Furniture Factory with oven.
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FIGURE L4.35
Simulation model layout of the Poly Furniture Factory.

FIGURE L4.36
Processes and routings at the Poly Furniture Factory.

The contents of a location can be displayed in one of the following two alternative ways:
a. To show the contents of a location as a counter, ﬁrst deselect the New
option from the Graphics toolbar. Left-click on the command button 00
in the Graphics toolbar (left column, top). Finally, left-click on the
location selected (Oven). The location counter will appear in the Layout
window next to the location Oven (Figure L4.35).
b. To show the contents of a location (Paint Booth) as a gauge, ﬁrst deselect
the New option from the Graphics toolbar. Left-click on the second
command button from the top in the left column in the Graphics toolbar.
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The gauge icon will appear in the Layout window next to the location
Paint Booth (Figure L4.35). The ﬁll color and ﬁll direction of the gauge
can now be changed if needed.

L4.5 Effect of Variability on Model Performance
Variability in the data makes a big impact on the performance of any system. Let
us take the example of Fantastic Dan, the barbershop in Section L4.1. Assume that
one customer arrives for getting a haircut every 10 minutes. Also, Dan takes exactly nine minutes for each haircut.
Let us modify the model of Section L4.1 to reﬂect the above changes. The arrival table is changed as shown in Figure L4.37 and the process table is changed
as shown in Figure L4.38. The results of the model with and without variability
are compared and shown in Table L4.2.

FIGURE L4.37
Customer arrival for haircut.

FIGURE L4.38
Processing of customers at the barbershop.

TABLE L4.2 Comparison of the Barbershop Model with and without
Variability

Average customer time at the barbershop
Average waiting in line for barber

With Variability

Without Variability

32.27 min.
22.95 min.

9 min.
0 min.
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L4.6 Blocking
With respect to the way statistics are gathered, here are the rules that are used in
ProModel (see the ProModel Users Manual, p. 636):
1. Average <time> in system: The average total time the entity spends in
the system, from the time it arrives till it exits the system.
2. Average <time> in operation: The average time the entity spends in
processing at a location (due to a WAIT statement) or traveling on a
conveyor or queue.
3. Average <time> in transit: The average time the entity spends traveling
to the next location, either in or out of a queue or with a resource. The
move time in a queue is decided by the length of the queue (deﬁned in
the queue dialog, Figure L4.16) and the speed of the entity (deﬁned in
the entity dialog, Figure L4.4 or L4.17).
4. Average < time> wait for resource, etc.: The average time the entity spends
waiting for a resource or another entity to join, combine, or the like.
5. Average < time> blocked: The average time the entity spends waiting for
a destination location to become available. Any entities held up behind
another blocked entity are actually waiting on the blocked entity, so they
are reported as “time waiting for resource, etc.”
Example
At the SoCal Machine Shop (Figure L4.39) gear blanks arriving to the shop wait
in a queue (Incoming_Q) for processing on a turning center and a mill, in that
FIGURE L4.39
The Layout of the SoCal Machine Shop.
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order. A total of 100 gear blanks arrive at the rate of one every eight minutes. The
processing times on the turning center and mill are eight minutes and nine minutes, respectively. Develop a simulation model and run it.
To ﬁgure out the time the “gear blanks” are blocked in the machine shop,
waiting for a processing location, we have entered “Move for 0” in the operation
logic (Figure L4.40) of the Incoming_Q. Also, the decision rule for the queue has
been changed to “No Queuing” in place of FIFO (Figure L4.41). This way all the
entities waiting in the queue for the turning center to be freed up are reported as
blocked. When you specify FIFO as the queuing rule for a location, only the lead
entity is ever blocked (other entities in the location are waiting for the lead entity
and are reported as “wait for resource, etc.”).
FIGURE L4.40
Process and Routing tables for SoCal Machine Shop.

FIGURE L4.41
Decision rules for Incoming_Q.
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FIGURE L4.42
Entity activity statistics at the SoCal Machine Shop.

FIGURE L4.43
Entity activity statistics at the SoCal Machine Shop with two mills.

From the entity activity statistics (Figure L4.42) in the output report we can see
the entities spend on average or 66.5 minutes in the system, of which 49.5 minutes
are blocked (waiting for another process location) and 17 minutes are spent in operation (eight minutes at the turning center and nine minutes at the mill). Blocking
as a percentage of the average time in system is 74.44 percent. The utilization of the
turning center and the mill are 98.14 percent and 98.25 percent, respectively.
In general, the blocking time as a percentage of the time in system increases as
the utilization of the processing locations increases. To reduce blocking in the machine shop, let us install a second mill. In the location table, change the number of
units of mill to 2. The entity activity statistics from the resulting output report are
shown in Figure L4.43. As expected, the blocking time has been reduced to zero.

L4.7 Exercises
1. Run the Tube Distribution Supply Chain example model (logistics.mod)
from the demos subdirectory for 40 hours. What are the various entities
modeled in this example? What are the various operations and processes
modeled in this example? Look at the results and ﬁnd
a. The percentage utilization of the locations “Mill” and the “Process
Grades Threads.”
b. The capacities of Inventory, and Inventory 2–6; the maximum
contents of Inventory and Inventory 2–6.
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c. The idle time percentage of the location “Mill.”
d. The percentage utilization of the resources Transport 1–5 and Fork
Lift 1–6.
e. What are the various states (in percentages) of the location “Process
Grades Threads”?
Run the Tube Distribution Supply Chain example model (logistics.mod)
for 40 hours.
a. What are the utilizations of the ﬁve transport resources? Is anyone
overutilized?
b. How well utilized are the six fork trucks? Can we reduce the ﬂeet of
fork trucks without much loss in the level of service?
Run the Warehouse model (deaerco.mod) from the demos subdirectory
for 100 hours. Run only Scenario 1. Go into the Simulation → Options
menu and change the Run Hours from 10 to 100.
a. What are the average value of inventory of Inventory Aisle 1–12?
b. What are the averages for Time to Fill, Box, and Check?
c. What is the Average Time in System?
d. What are the cost of customer order, receiving order, and the sum
total of cost per order?
e. What are the percentage idle times for Checker 1 and Checker 2?
f. What are the utilizations of Boxers 1–4 and the average utilization of
all the Boxers?
Run the Aircraft Fuselage Mating example model (assembly.mod) from
the Student subdirectory for 80 hours. Answer the following questions:
a. What are the utilizations of the Drill and the Cutter?
b. What percentage of time were the Paint, Assembly Jig Q, and
KittingQ fully occupied?
c. What is the percentage utilization of the Crane?
d. What is the average time a Fuselage spends in the system?
Run the Book Storage (Booksmod.mod) example model from the
Student subdirectory for eight hours. Answer the following questions.
a. What are the utilizations of the forklift (JACK) and the material
handler (MTHDLR)?
b. What is the average time spent in the system by order A, order B,
order C, and order D?
c. What is the percentage of time the orders are waiting for a resource?
Which resource? What if any are the problems? What can you suggest
to improve the situation?
For the example in Section L4.1 (Fantastic Dan), run the simulation
model for a whole year (250 days, eight hours each day) and answer the
following questions:
a. On average, how many customers does Dan serve each day?
b. What is the average number of customers waiting to get a haircut?
What is the maximum?
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c. What is the average time spent by a customer in the salon?
d. How busy is Dan on average? Is this satisfactory?
e. How many chairs should Dan have for customers waiting for a haircut?
If Dan could take exactly nine minutes for each haircut, will it improve
the situation? Rework Question 1 and answer parts a through e.
For the example in Section L4.1, what will happen if we change the
capacity of the location Waiting_for_Barber to one? Is this change
desirable? What are the implications? Make the appropriate change in
the model and show the results to support your argument.
For the Bank of USA ATM example in Section L4.2, run the model with
and without any variability in the customer interarrival time and service
time. Compare the average time in system and the average time in queue
based on 1000 hours of simulation runs.
For the SoCal Machine Shop in Section L4.6 assume the length of the
Incoming_Q is 30 feet, and the speed of the arriving Gear_Blanks is
10 feet/minute. Delete the statement Move for 0 in the operation logic
of the Incoming_Q. Change the queuing rule to FIFO. Answer the
following questions and explain why.
a. What is the average time in operation?
b. What is the average time waiting for resource?
c. What is the average time blocked?
In the Arrivals element (table), what are the differences between
Occurrences and Frequency? What is the signiﬁcance of the Qty each
column?
In the Locations element (table), what are the differences between Cap
and Units?
What are the various time units that can be used while developing a
model? Where is this information provided? If one forgets to specify the
time unit in the model, what time unit is used by ProModel?
The Processing element has two tables that need to be edited. What are
their names and their functions?
When an entity has completed all the processing in the system, what
should we do with it? Where should it be routed?
Differentiate between the following:
a. Entity versus locations.
b. Locations versus resources.
c. Attributes versus variables.
d. Save versus Save As.
e. Move, Move For, Move On, Move With.
f. Wait versus Wait Until.
g. Stop versus End.
Increased utilization of processing locations or resources lead to
increased levels of blocking in the system. Explain why.

